TxDMV RTS Guide for Running Daily, Weekly, and Monthly RTS Activity Reports

02/16/16
**Revision History**

The chart below shows the information added or revised in each release of this document after its initial release in May, 2015.

<table>
<thead>
<tr>
<th>RELEASE DATE</th>
<th>ADDITION/REVISION MADE</th>
</tr>
</thead>
</table>
| 06/12/2015   | Added note about not covering all reports  
|              | Added Appendix E. Locating Mainframe Reports Formerly Download…  
|              | Added Legacy Report Number Reference  
|              | Revised Print/Email sections for all Cognos reports  
|              | Added Weekly Inventory Transaction Information section |
| 06/18/2015   | Added Special County Invoice Report Information  
|              | Added note about running multiple reports at one time |
| 07/14/2015   | Changed intro to steps to be in logical order  
|              | Added Weekly County IRP Transmittal section |
| 08/28/2015   | Revised the Date prompt for Daily Funds Remittance Report to *Business day before yesterday*  
|              | Added Short Week Info in Weekly Funds Remittance Report and in Quick Path |
| 09/28/2015   | Added NMVTIS Report Email information  
|              | Added note about how to add Cognos users |
| 10/12/2015   | Changed “last Monday” to “Monday of previous week” for Weekly Funds Remittance Report (Monday Reg) on page 37 and page 114; and Weekly Funds Summary Report on page 41 and page 114  
|              | Removed step “For Select Fee Source, click CUSTOMER“ and replaced with a note not to select anything for Week to Dates Fees prompts on page 57 and page 115 |
| 10/31/2015   | Replaced the Fee Collection and Distribution Report page screen shot on page 79 with the revised screen shot containing the new Funds Category prompt and added the step for the new prompt. Added the Funds Category prompt to the Quick Path on page 117 |
| 12/10/2015   | Corrected the number of the Production Report to 9482 in several places |
| 01/28/2015   | In the Weekly Funds Remittance report (aka Monday Reg), on the Prompts page, corrected the instruction in Step 3a Select Funds Type from selecting “Registration” to “do not select any option” on page 37, 41, and114 |
| 02/16/2016   | Revised instructions and added new Sample report for the NMVTIS Inquiry Report on page 28 and 113 |
About this Guide

This guide provides instructions to enable you to manually run reports you may need for the RTS POS transactions that were formerly downloaded and printed to your printer automatically on a daily, weekly, and monthly basis (referred to as *legacy reports*). Information about other commonly run legacy reports (Apprehension, CRBF, and $5 Buyer Tag Fees) that may be run on-demand are also included in this guide.

You must be assigned the appropriate permissions to run reports, including Cognos Enterprise Reports. Your county RTS Admin assigns this to you on the Reports page in the Local Options >Security event. For more information, refer to the Adding Cognos Users job aid available from the Job Aids tab on the RTS Resources page on the TAC Hub ([http://www.txdmv.gov/rts-refactoring-resources or click the 🌐 RTS Refactoring Resources Help icon on your desktop](http://www.txdmv.gov/rts-refactoring-resources)).

**Note:** If you do not know who in your county is an RTS Admin, contact the service/help desk for assistance.

Instead of printing unnecessary reports, you can now determine the report information you need and then run only the reports you need when you need them. Many former RTS reports have been consolidated and defined as Cognos reports with configurable options for greater flexibility.

Although you will manually run most of the daily, weekly, and monthly reports in Cognos, there are some that remain in the refactored RTS POS directly.

To help you determine which reports to run, the sections in this guide are titled with the information formerly gathered in the legacy reports (for example, Daily Title Funds Summary and Transactions Information). Each section identifies the former RTS report number and contains the steps for locating the report and running it. Where possible, a sample report is also included to provide an illustration of what you can expect.

Once you are comfortable running the reports, you can use the sections in the Appendix that provide quick paths for running the reports without explanations.

**Note:** This guide covers the set of standard reports, but may not cover all reports that your office runs on a daily, monthly, weekly, or ad-hoc basis. Although the instructions contain the appropriate prompts for running these reports on a specific basis, you can run or reprint the reports on-demand using other prompt information at whatever interval you need.
# Table of Contents

## Running Daily Reports

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily BIAR, Countywide, Title Package, and Completed Set Aside Transaction Reports</td>
<td>2</td>
</tr>
<tr>
<td>Daily Substation Reports</td>
<td>4</td>
</tr>
<tr>
<td>Daily Funds Remittance Title Information</td>
<td>7</td>
</tr>
<tr>
<td>Daily Funds Summary and Transaction Information</td>
<td>12</td>
</tr>
<tr>
<td>Daily County Special Plates Invoice Information</td>
<td>17</td>
</tr>
<tr>
<td>Daily Voided Transaction Information</td>
<td>23</td>
</tr>
<tr>
<td>Daily NMVITIS Information</td>
<td>28</td>
</tr>
<tr>
<td>Running the NMVITIS Report to Completion and Printing It</td>
<td>28</td>
</tr>
<tr>
<td>Running the NMVITIS Report and Emailing It Before It Completes</td>
<td>31</td>
</tr>
</tbody>
</table>

## Running Weekly Reports

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weekly Funds Remittance (Monday Reg/IRP) Information</td>
<td>36</td>
</tr>
<tr>
<td>Short Week Weekly Funds Remittance (Monday Reg)</td>
<td>40</td>
</tr>
<tr>
<td>Weekly Funds Transactions and Summary (Monday Reg/IRP) Information</td>
<td>46</td>
</tr>
<tr>
<td>Week-To-Date Cash Drawer and Week-To-Date Fees Information</td>
<td>55</td>
</tr>
<tr>
<td>Weekly Inventory Transaction Information</td>
<td>62</td>
</tr>
<tr>
<td>Weekly County IRP Transmittal Invoice Information</td>
<td>67</td>
</tr>
</tbody>
</table>

## Running Monthly Reports

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly Funds Information</td>
<td>73</td>
</tr>
<tr>
<td>Monthly Title and Registration Summary Information</td>
<td>78</td>
</tr>
<tr>
<td>Month-To-Date Fees Information</td>
<td>84</td>
</tr>
<tr>
<td>Monthly Employee Production Information</td>
<td>91</td>
</tr>
</tbody>
</table>

## Other Report Information

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apprehension Information</td>
<td>97</td>
</tr>
<tr>
<td>CRBF Information</td>
<td>101</td>
</tr>
<tr>
<td>$5 Buyer Tag Fee Information</td>
<td>106</td>
</tr>
</tbody>
</table>

## Appendix A. Daily Reports Quick Path

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix A. Daily Reports Quick Path</td>
<td>111</td>
</tr>
</tbody>
</table>

## Appendix B. Weekly Reports Quick Path

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix B. Weekly Reports Quick Path</td>
<td>114</td>
</tr>
</tbody>
</table>

## Appendix C. Monthly Reports Quick Path

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix C. Monthly Reports Quick Path</td>
<td>117</td>
</tr>
</tbody>
</table>

## Appendix D. Daily Substation RTS POS Reports Quick Path

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix D. Daily Substation RTS POS Reports Quick Path</td>
<td>119</td>
</tr>
</tbody>
</table>

## Appendix E. Printing Cognos Reports

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix E. Printing Cognos Reports</td>
<td>120</td>
</tr>
<tr>
<td>Printing a Cognos Report PDF from the Cognos Viewer</td>
<td>120</td>
</tr>
<tr>
<td>Exporting a Cognos Report PDF into Excel and Printing It</td>
<td>121</td>
</tr>
</tbody>
</table>

## Appendix F. Locating the Mainframe Reports Formerly Downloaded and Printed Automatically

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix F. Locating the Mainframe Reports Formerly Downloaded and Printed Automatically</td>
<td>123</td>
</tr>
</tbody>
</table>
Legacy Report Number Reference

The following provides a reference to the appropriate Cognos information from a legacy report number perspective.

<table>
<thead>
<tr>
<th>FORMER REPORT</th>
<th>PG #</th>
</tr>
</thead>
<tbody>
<tr>
<td>3461/3463 $5 Buyer Tag Fees</td>
<td>106</td>
</tr>
<tr>
<td>3564 Special Plates County Invoice</td>
<td>17</td>
</tr>
<tr>
<td>3664 NMVITIS Inquiry Error</td>
<td>23</td>
</tr>
<tr>
<td>4552 Week-to-Date Cash Drawer</td>
<td>55</td>
</tr>
<tr>
<td>456B2, 456B3, 456C4 Week-to-Date Fees</td>
<td>55</td>
</tr>
<tr>
<td>458B2 Month-to-Date Fees (Consolidated Collections)</td>
<td>84</td>
</tr>
<tr>
<td>458B3 Month-to-Date Fees (Fee Source)</td>
<td>84</td>
</tr>
<tr>
<td>4602 Funds Transactions (Monday Reg/IRP)</td>
<td>46</td>
</tr>
<tr>
<td>4602 Funds Transactions (Title)</td>
<td>12</td>
</tr>
<tr>
<td>4603 Funds Summary</td>
<td>12</td>
</tr>
<tr>
<td>4603 Funds Summary (Monday Reg/IRP)</td>
<td>46</td>
</tr>
<tr>
<td>4604 Funds Remittance (Monday Reg/IRP)</td>
<td>36</td>
</tr>
<tr>
<td>4604 Funds Remittance (Title)</td>
<td>7</td>
</tr>
<tr>
<td>4672 Apprehension Report</td>
<td>97</td>
</tr>
<tr>
<td>4702 Inventory Transactions</td>
<td>62</td>
</tr>
<tr>
<td>4802 Monthly Funds/Registration Emissions Fee</td>
<td>73</td>
</tr>
<tr>
<td>4802 Monthly Funds/Sales Tax Penalty</td>
<td>63</td>
</tr>
<tr>
<td>4802 Monthly Funds/Young Farmer Program</td>
<td>63</td>
</tr>
<tr>
<td>4802 Sales Tax</td>
<td>73</td>
</tr>
<tr>
<td>4802 Sales Tax Emission Fee 1%</td>
<td>73</td>
</tr>
<tr>
<td>4802 TERP Fee</td>
<td>73</td>
</tr>
<tr>
<td>4802 Texas Mobility Fund</td>
<td>73</td>
</tr>
<tr>
<td>4882 Registration and Title Emissions Summary</td>
<td>73</td>
</tr>
<tr>
<td>4883 Registration and Title Emissions</td>
<td>73</td>
</tr>
<tr>
<td>5152 Voided Transaction</td>
<td>23</td>
</tr>
<tr>
<td>5901 Countywide Batch (Payment Type, Fees, Inventory, Exceptions)</td>
<td>1</td>
</tr>
<tr>
<td>5911 Title Package</td>
<td>2</td>
</tr>
<tr>
<td>5921 Substation Batch</td>
<td>4</td>
</tr>
<tr>
<td>7472 County IRP Transmittal Invoice</td>
<td>67</td>
</tr>
<tr>
<td>9021 Completed Set Aside Transactions</td>
<td>1</td>
</tr>
<tr>
<td>9353 Title and Registration Summary</td>
<td>78</td>
</tr>
<tr>
<td>9482 Employee Production</td>
<td>91</td>
</tr>
<tr>
<td>9901 Batch Inventory Action (BIAR)</td>
<td>1</td>
</tr>
<tr>
<td>CRBF Report</td>
<td>101</td>
</tr>
</tbody>
</table>
Running Daily Reports

The daily reports that you used to pull from your printer are now available to you to run manually as Cognos reports or from the POS Reprint Reports event.

The reports that are manually run from the Reports > Reprint reports include reports you may be used to working with and reprinting from the POS:

- 9901 Batch Inventory Action (BIAR)
- 5901 Countywide Batch (Payment Type, Fees, Inventory, Exceptions)
- 5911 Title Package
- 5921 Substation Summary Batch
- 9021 Completed Set Aside Transactions

The steps for reprinting the reports are covered in respective sections. For the reports that were converted to Cognos reports, the steps for manually running the reports, including selecting the report and supplying values on the Prompts page that displays, are described in detail. Samples of the reports are provided at the end of each report section to help you work with the new reports.

Many of the names of the Cognos match up to the name of the former mainframe report (like the Funds Remittance Report and the Voided Transaction reports). However, some reports, like similarly named summary and detail reports, have been combined into one report that contains a summary section at the top and sets of details in their own tables.

The Cognos reports you can manually run daily if you need this information include:

- **Funds Remittance Report** to gather the information in the former 4604 Funds Remittance (Title) report.
- **Fee Types Funds Report** to gather the information in the former 4602 Funds Transactions (Title) and 4603 Funds Summary reports. Note that the former Transactions and Summary information is combined into one Fee Types Funds Report for convenience with a summary section at the top and sets of details in their own tables.
- **Special County Invoice Report** to gather the information in the former 3564 Special Plates County Invoice.
- **Voided Transactions Report** to gather the information in the former 5152 Voided Transaction report.
- **NMVITIS Inquiry Report** to gather the information in the former 3664 NMVITIS Inquiry Error report.
Daily BIAR, Countywide, Title Package, and Completed Set Aside Transaction Reports

The main TAC office can manually run the following daily reports from the POS using the Reports > Reprint Reports event.

- 9901 Batch Inventory Action (BIAR)
- 5901 Countywide Batch (Payment Type, Fees, Inventory, Exceptions)
- 5911 Title Package
- 9021 Completed Set Aside Transactions

Note: Each TAC substation can manually run daily reports for their office. Refer to Daily Substation Reports on page 4.

By default, the reports will print directly to your default printer; however, you can select (on the Reprint Reports page) to have the reports display onscreen and then send them to your printer.

1. After logging into the RTS POS, click Reports from the main page access bar and then click Reprint Reports.
2. On the Reprint Reports RPR002 page:

3. In the list of reports displayed (on the Batch category page), select **Batch Inventory Action**.

4. Press and hold the **Shift** key on your keyboard as you select the **Completed Set Aside Transaction**, **Countywide Batch** and **Title Package** reports.

5. To display the reports onscreen before they print, click the **Display report(s) before printing** checkbox.

6. Click the **Enter** button.

7. If the reports will display onscreen:
   a. Verify the information and click the **Print** button.
   b. On the **Print RPR008** page, click the **Enter** button.
   c. Repeat steps a and b for each report displayed.
Daily Substation Reports

The substations of the main TAC office can manually run the following daily reports from the POS using the Reports > Reprint Reports event:

- 9901 BIAR Report
- 5911 Title Package
- 5921 Substation Summary Batch (which contains the 5922 Substation Fees and 5923 Substation Inventory)
- 9021 Completed Set Aside Transactions

By default, the reports will print directly to your default printer; however, you can select (on the Reprint Reports page) to have the reports display onscreen and then send them to your printer.

1. After logging into the RTS POS, click Reports from the main page access bar and then click Reprint Reports.
2. On the Reprint Reports RPR002 page:

   ![Image of Reprint Reports RPR002 page]

   (Note: Image shows the Report Category options, including Batch, Funds, Inventory, Title, and Other.
   It also displays the display report(s) before printing checkbox.
   Report descriptions include Batch Inventory Action, Completed Set-Aside Transaction, Countywide Batch, and Title Package.
   Date and Time columns show various timestamps.)

3. From the list of reports displayed (on the Batch category page), select **Batch Inventory Action**.

4. Press and hold the **Shift** key on your keyboard as you select the **Completed Set Aside Transaction**, **Countywide Batch**, and **Title Package** reports.

5. To display the reports onscreen before they print, click the **Display report(s) before printing** checkbox.

6. Click the **Enter** button.

7. If the reports will display onscreen:
   a. Verify the information in the BIAR and click the **Print** button.
   b. On the **Print RPR008** page, click the **Enter** button.
   c. Repeat steps a and b for the Title Package report.
8. Back on the Reprint Reports RPR002 page, click the Funds option (in the Select a Report Category area).

9. Locate and select Substation Summary Online.

10. To display the report onscreen before it prints, click the Display report(s) before printing checkbox.

11. Click the Enter button.

12. If the report will display onscreen:
   a. Verify the information and click the Print button.
   b. On the Print RPR008 page, click the Enter button.
Daily Funds Remittance Title Information

The information gathered in the former 4604 Funds Remittance (Title) report is now available in the **Funds Remittance Report** in Cognos.

1. After logging into Cognos and displaying the **Public Folders** area on the Cognos Connection home page, click the 📁 **Finance** folder.

   ![Cognos Treasury Connection]

   2. In the Finance reports list displayed, locate and click 📁** Funds Remittance Report.**

      **Note:** To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click **Open in new tab**, and then click the tab open.
3. On the **Prompts** page:

![Image](image.jpg)

a. For **Select Start Date**, click the calendar and select the date representing the business day before yesterday.

b. For **Select End Date**, click the calendar and select the date representing the business day before yesterday.

c. For **Select Office**, click the drop-down list and click your office.

d. For **Select Funds Type**, click TITLE.

e. Click the **Finish** button.

4. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   **Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
To wait and print directly from the onscreen display:

a. From the Adobe toolbar that displays across the top of the report, click (Print).

b. On the Print pop-up, to use the:
   
   o Default RTS Printer tray:
     Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
     1) From the Printer drop-down, select RTS-Tray-2.
     2) Click the Print button.
   
   o Manual feed tray of your RTS printer:
     1) Pull down Tray 1 and load paper into it.
     2) From the Printer drop-down, select RTS-Tray-1.
     3) Click the Print button.

c. From the Cognos Viewer toolbar, click to return to the Finance reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click **Select a delivery method**.

b. From the options displayed, click **Email Report**.

c. On the **Set the email options** page, supply the necessary information.

d. Click the **OK** button to close this page and return to the **Finance** reports list.
Sample Report

The Daily Funds Remittance Report (Title) provides the space for the signature, date, and check or electronic fund transfer information for the remittance.
Daily Funds Summary and Transaction Information

The information gathered in the former 4602 Funds Transactions (Title) and 4603 Funds Summary reports is now available in the Fee Types Funds report in Cognos.

**Note:** For the Monday Reg/IRP information, refer to Weekly Funds Transactions and Summary (Monday Reg/IRP) Information on page 46.

1. In the Finance folder reports list, click Fee Type Funds Report.

   **Notes:**
   (1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders area or click the Public Folder tab on the Cognos page currently displayed, and then click the Finance folder.
   (2) To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open
2. On the **Prompts** page:

![Prompts page screenshot]

a. For **Select Start Date**, click the \( \text{ } \) and click the date for yesterday.

b. For **Select End Date**, click the \( \text{ } \) and click date for yesterday.

c. For **Select Office**, click the drop-down list and click your office.

d. For **Select Fee Type**, click the drop-down list and click **Title**.

e. Click the **Finish** button.

3. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

**Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
• To wait and print directly from the onscreen display:
  a. From the Adobe toolbar that displays across the top of the report, click (Print).
  b. On the Print pop-up, to use the:
     o **Default** RTS Printer tray:
       Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
       1) From the **Printer** drop-down, select **RTS-Tray-2**.
       2) Click the **Print** button.
     o **Manual feed** tray of your RTS printer:
       1) Pull down Tray 1 and load paper into it.
       2) From the **Printer** drop-down, select **RTS-Tray-1**.
       3) Click the **Print** button.
  c. From the Cognos Viewer toolbar, click to return to the **Finance** reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click **Select a delivery method**.

b. From the options displayed, click **Email Report**.

c. On the **Set the email options** page, supply the necessary information.

d. Click the **OK** button to close this page and return to the **Finance** reports list.
Sample Report

The Daily Fee Type Funds Report contains a summary of the fees collected during title transactions as well as the displays the transactions involved for each fee.
Daily County Special Plates Invoice Information

The information gathered in the former 3564 Special Plates County Invoice report is now available in the County Special Plates Invoice Report in Cognos.

1. On the Finance reports list, click the Public Folders tab on the Cognos Connection home page.

   **Note:** If you are not on the Finance reports list, log in to Cognos to display the Public Folder area or click the Public Folder tab on the Cognos page currently displayed.

2. In the Public Folders area, click the Registration folder.

3. In the Registration reports list displayed, click the Special Plate Registration folder.

4. In this reports list, locate and click County Special Plates Invoice Report.

   **Note:** To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.
5. On the Prompts page:

   ![Image of Prompts page]

   a. For **Select Start Date**, click the calendar and select the date for yesterday.

   b. For **Select End Date**, click the calendar and select the date for yesterday.

   c. For **Select Office**, click your office.

   d. Click the **Finish** button.

6. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   **Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
• To wait and print directly from the onscreen display:
  a. From the Adobe toolbar that displays across the top of the report, click (Print).
  b. On the Print pop-up, to use the:
     o Default RTS Printer tray:
       Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
       1) From the Printer drop-down, select RTS-Tray-2.
       2) Click the Print button.
     o Manual feed tray of your RTS printer:
       1) Pull down Tray 1 and load paper into it.
       2) From the Printer drop-down, select RTS-Tray-1.
       3) Click the Print button.
  c. From the Cognos Viewer toolbar, click to return to the Special Plate Registration reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click **Select a delivery method**.

b. From the options displayed, click **Email Report**.

c. On the **Set the email options** page, supply the necessary information.

d. Click the **OK** button to close this page and return to the **Special Plates Registration** reports list.
Sample Report

The County Special Plates Invoice Report may span several pages to show all of the special plates purchased during the day specified. The last page of the report shows the total number of special plates in the report.

![Sample Report](image-url)
## Williamson County Special Plates Invoice Report

<table>
<thead>
<tr>
<th>Base Registration Plate Code</th>
<th>Registration Plate Code</th>
<th>Owner Name</th>
<th>Owner City</th>
<th>Manufacturing Plate Number</th>
<th>Document Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registration Plate Code Total - PER WILDLIFE PLT</td>
<td>WILDLIFE PLT</td>
<td>[Redacted]</td>
<td>CEDAR PARK</td>
<td>6V78D</td>
<td>1</td>
</tr>
<tr>
<td>Registration Plate Code Total - WILDLIFE PLT</td>
<td>WILDLIFE PLT</td>
<td>[Redacted]</td>
<td>CEDAR PARK</td>
<td>6V78D</td>
<td>1</td>
</tr>
<tr>
<td>Base Registration Plate Code Total - WILDLIFE PLT</td>
<td>WILDLIFE PLT</td>
<td>[Redacted]</td>
<td>CEDAR PARK</td>
<td>6V78D</td>
<td>2</td>
</tr>
<tr>
<td>Woman Veteran PLT</td>
<td>PER WOMAN VETERAN PLT</td>
<td>D [Redacted]</td>
<td>THRAIL</td>
<td>GUNGO</td>
<td>24233453455151047</td>
</tr>
<tr>
<td>Registration Plate Code Total - PER WOMAN VETERAN PLT</td>
<td>WILDLIFE PLT</td>
<td>[Redacted]</td>
<td>CEDAR PARK</td>
<td>6V78D</td>
<td>1</td>
</tr>
<tr>
<td>Base Registration Plate Code Total - WOMAN VETERAN PLT</td>
<td>WILDLIFE PLT</td>
<td>[Redacted]</td>
<td>CEDAR PARK</td>
<td>6V78D</td>
<td>1</td>
</tr>
<tr>
<td>Plate Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>30</td>
</tr>
</tbody>
</table>

Run Date: 06/08/2015
Run Time: 3:10:23 AM
Daily Voided Transaction Information

The information gathered in the former 5152 Voided Transaction report is now available in the Voided Transaction Report in Cognos.

1. On the **Title** reports list displayed, click the **Public Folder tab** area on the Cognos Connection home page.
   
   **Note:** If you are not on the **Title** reports list, log in to Cognos to display the Public Folder tab area or click the **Public Folder** tab on the Cognos page currently displayed.

2. From the list of folders displayed, click the **Administrative** folder.

3. In the reports list displayed, locate and click the **Voided Transactions Report**.
   
   **Note:** To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click **Open in new tab**, and then click the tab open.
4. On the **Prompts** page:

![Image of the Prompts page]

a. For **Transaction Start Date**, click the calendar and select the date for yesterday.

b. For **Transaction End Date**, click the calendar and select the date for yesterday.

c. For **Office Type**, click **COUNTY**.

d. Click the **Refresh Office** button.

e. For **Office**, click your office.

f. Click the **Finish** button.

5. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

**Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
To wait and print directly from the onscreen display:

a. From the Adobe toolbar that displays across the top of the report, click (Print).

b. On the Print pop-up, to use the:
   - **Default** RTS Printer tray:
     - **Tip:** To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
     1) From the Printer drop-down, select **RTS-Tray-2**.
     2) Click the Print button.
   - **Manual feed** tray of your RTS printer:
     1) Pull down Tray 1 and load paper into it.
     2) From the Printer drop-down, select **RTS-Tray-1**.
     3) Click the Print button.

   ![Print window](image)

   c. From the Cognos Viewer toolbar, click to return to the **Administrative** reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click **Select a delivery method**.

b. From the options displayed, click **Email Report**.

c. On the **Set the email options** page, supply the necessary information.

d. Click the **OK** button to close this page and return to the **Administrative** reports list.
Sample Report

The Voided Transaction report may span multiple pages. The information shows the transaction IDs and the name of the user who logged into the workstation where the voided transaction occurred.
Daily NMVITIS Information

The information gathered in the former 3664 NMVITIS Inquiry Error report is now available in the NMVITIS Inquiry Report in Cognos.

Note: This report is generated in Excel Worksheet format.

Unlike other Cognos reports, you must determine if you want to email the report from Cognos while it is being generated. Refer to the appropriate section:

- Running the NMVITIS Report to Completion and Printing It
- Running the NMVITIS Report and Emailing It Before It Completes (page 31)

Running the NMVITIS Report to Completion and Printing It

1. On the Special Plate Registration reports list displayed, click the Public Folders tab on the Cognos Connection home page.

   Note: If you are not on the Special Plate Registration reports list, log in to Cognos to display this tab area or click the Public Folder tab on the Cognos page currently displayed.

2. From the list of folders displayed, click the Title folder.

3. In the Title reports list displayed, locate and click NMVITIS Inquiry Report.

   Note: To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.
4. On the Prompts page:

a. For **Select Start Date**, click the calendar and select the date for yesterday.

b. For **Select End Date**, click the calendar and select the date for yesterday.

c. For **Select Type**, leave **Error** selected.

d. For **Select Salvage Indicator**, leave **Non-Salvage** selected.

e. For **Select Office**, click the drop-down list and click your office.

f. Click the **Finish** button.

g. If you are running this report:

   - In a series of reports - each in their own windows, click the **Public Folders** tab to return to the reports list to run the next report and then follow the instructions to print it in Appendix E on page 120.
• To completion:

1) When the Open/Save popup displays along the bottom of the page, click the Open button.

2) At the top of the report page, click File > Print.

3) On the Print page:

   a. From the Printer drop-down, select either the:
      - Default RTS Printer tray (To avoid using up the “500” paper inventory, load plain paper in this tray.)
      - RTS-Tray-1 to use the manual tray and load plain paper into the tray.
b. From the **Portrait Orientation** drop-down, select **Landscape Orientation**.

c. From the **No Scaling** drop-down, select **Fit All Columns on One Page**.

d. Click the **Print** button and then close the Excel report to return to the Title folder reports list.

**Running the NMVITIS Report and Emailing It Before It Completes**

1. On the **Special Plate Registration** reports list displayed, click the **Public Folders** tab on the Cognos Connection home page.

   **Note:** If you are not on the **Special Plate Registration** reports list, log in to Cognos to display this tab area or click the **Public Folder** tab on the Cognos page currently displayed.

2. From the list of folders displayed, click the **Title** folder.

3. In the Title reports list displayed, locate and click **NMVITIS Inquiry Report**.

   **Note:** To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click **Open in new tab**, and then click the tab open.
4. On the **Prompts** page:

   a. For **Select Start Date**, click the calendar and select the date for yesterday.

   b. For **Select End Date**, click the calendar and select the date for yesterday.

   c. For **Select Type**, leave **Error** selected.

   d. For **Select Salvage Indicator**, leave **Non-Salvage** selected.

   e. For **Select Office**, click the drop-down list and click your office.

   f. Click the **Finish** button.

5. On the **Report is running** pop-up, click **Select a delivery method**.
6. From the options displayed, click **Email Report**.

![Email Report Dialogue](image1)

7. On the **Set the email options** page, supply the necessary information.

![Email Options](image2)

8. Click the **OK** button to close this page and return to the **Title** reports list.
Sample Report

The NMVTIS Inquiry Report is formatted as an Excel spreadsheet file by default. When it displays onscreen, it is typically more than several screens long – although it may print off in several pages.

On 02/16/2016, several columns are automatically suppressed when county end users run the report (such as the Office, Regional Office, Type, and Salvage Indicator) and word wrapping within each column is enabled. The report looks similar to the following.

<table>
<thead>
<tr>
<th>Date</th>
<th>Substation</th>
<th>Document Number</th>
<th>VIN</th>
<th>Previous Jurisdiction</th>
<th>Message Text</th>
<th>Message Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/01/2016</td>
<td>1 - DALLAS COUNTY BACK ROOM</td>
<td>057332423696250033</td>
<td>1WYASTA34FC151711</td>
<td>VIN POINTER RECORD FOUND FOR NEW VIN</td>
<td>902</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 - DALLAS COUNTY PUBLIC</td>
<td>05732423696101606</td>
<td>1Q6R08X4C5S252398</td>
<td>NM NO VIN POINTER RECORD FOR EXISTING VIN</td>
<td>902</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05732423696101526</td>
<td>JNACV56ED6M615246</td>
<td>VA NO VIN POINTER RECORD FOR EXISTING VIN</td>
<td>902</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05732423696102521</td>
<td>2D812BS36ED010999</td>
<td>FL NO VIN POINTER RECORD FOR EXISTING VIN</td>
<td>902</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05732423696104915</td>
<td>1G1CP55SB6F714084</td>
<td>CA VIN POINTER TITLE ISSUE DATE IS DIFFERENT FROM SURRENDERED TITLE</td>
<td>907</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05732423696034561</td>
<td>1KRS6A331AA170187</td>
<td>IA NO VIN POINTER RECORD FOR EXISTING VIN</td>
<td>902</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0573242369601232</td>
<td>2H4RL9601H0327849</td>
<td>KS NMVTIS HAS BRAND 09 FROM VA THAT TX DOES NOT</td>
<td>910</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0573242369605439</td>
<td>1GND513B2G2355292</td>
<td>AR NO VIN POINTER RECORD FOR EXISTING VIN</td>
<td>902</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05732423696103436</td>
<td>VWGL7AX4D6W51486</td>
<td>CA VIN POINTER TITLE ISSUE DATE IS DIFFERENT FROM SURRENDERED TITLE</td>
<td>907</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0573242369612929</td>
<td>1N4AL11D65C151327</td>
<td>LA VIN POINTER TITLE ISSUE DATE IS DIFFERENT FROM SURRENDERED TITLE</td>
<td>902</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05732423696092491</td>
<td>1N4AL215E7N450579</td>
<td>VA VIN POINTER TITLE ISSUE DATE IS DIFFERENT FROM SURRENDERED TITLE</td>
<td>907</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>057331423696104143</td>
<td>1Q1Y18U375112168</td>
<td>CO VIN POINTER TITLE ISSUE DATE IS DIFFERENT FROM SURRENDERED TITLE</td>
<td>907</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05734042369030001</td>
<td>1N4ALJPSDC214541</td>
<td>WV VIN POINTER JURISDICTION IS DIFFERENT FROM SURRENDERED TITLE</td>
<td>905</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05734042369010637</td>
<td>2F8D0K36C7FB30626</td>
<td>OK VIN POINTER TITLE ISSUE DATE IS DIFFERENT FROM SURRENDERED TITLE</td>
<td>902</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05734042369133411</td>
<td>JT4RN81D3F4503987</td>
<td>CA NO VIN POINTER RECORD FOR EXISTING VIN</td>
<td>902</td>
<td></td>
</tr>
<tr>
<td>02/01/2016</td>
<td>7 - GRAND PRAIRIE SUBSTATION</td>
<td>05700242369140917</td>
<td>1HTMSAAR2KDB87230</td>
<td>VA VIN POINTER JURISDICTION IS DIFFERENT FROM SURRENDERED TITLE</td>
<td>905</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05733424298001439</td>
<td>1GDKP22Y43509437T</td>
<td>OK VIN POINTER TITLE ISSUE DATE IS DIFFERENT FROM SURRENDERED TITLE</td>
<td>907</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05733424298014039</td>
<td>1N4AL11D526M486168</td>
<td>VA VIN POINTER TITLE ISSUE DATE IS DIFFERENT FROM SURRENDERED TITLE</td>
<td>907</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>05733424298034165</td>
<td>JAM1B221EF034101</td>
<td>TX NMVTIS HAS BRAND 09 FROM OK THAT TX DOES NOT</td>
<td>910</td>
<td></td>
</tr>
</tbody>
</table>
Running Weekly Reports

The weekly reports that you used to pull from your printer are now available to you to run manually as Cognos reports. The following sections include the steps for manually running the reports, including selecting the report and supplying values on the Prompts page that displays. Samples of the reports are provided at the end of each report section to help you work with the new reports.

Many of the names of the Cognos match up to the name of the former mainframe report (like the Funds Remittance Report and the Voided Transaction reports). However, some reports, like similarly named summary and detail reports, have been combined into one report that contains a summary section at the top and sets of details in their own tables.

The Cognos reports you can manually run for weekly information if you need this information include:

- **Funds Remittance Report** to gather the information in the former report 4604 Funds Remittance Monday Registration and the 4604 Funds Remittance for IRP reports.

  Note: The procedure for running the short week Funds Remittance report is slightly different. To avoid extra information, you must run the report two business days after the month ends. Refer to page 40.

- **Fee Types Funds Report** to gather the information in the former 4602 Funds Transactions Monday Registration/IRP and 4603 Funds Summary Monday Registration/IRP reports. You will run a Fee Type Funds Report for the Registration data and another one for IRP data). Note that the former Transactions and Summary information is combined into one Fee Types Funds Report for convenience with a summary section at the top and sets of details in their own tables.

- **Week/Month-To-Date Fees Report** to gather the information in the former 4552 Week-to-Date Cash Drawer and the 456B2, 456B3, and 456C4 Week-to-Date Fees reports. The Cash Drawer information is in a table within the report.

- **Inventory Transactions Report** to gather the information in the former 4702 Inventory Transaction report.

*Note: The County IRP Transmittal Invoice Report* to replace the 7472 County IRP Transmittal Invoice information is not yet available in Cognos. Refer to the latest Release Notes for information about receiving this report.
Weekly Funds Remittance (Monday Reg/IRP) Information

The information gathered in the former 4604 Funds Remittance (Monday Registration/IRP) report is now available in the Funds Remittance Report in Cognos.

**Note:** For a short week, refer to the next section on page 40.

1. After logging into Cognos and displaying the Public Folders area on the Cognos Connection home page, click the Finance folder.

2. In the Finance reports list displayed, locate and click Funds Remittance Report.

   **Note:** To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.
3. On the **Prompts** page:

   ![Prompts Page Image]

   a. For **Select Start Date**, click the calendar and select the date for the Monday of the previous week (for example, if you are running this report on Tuesday, September 29, you would select Monday, September 21).

   b. For **Select End Date**, click the calendar and select the date for last Sunday.

   c. For **Select Office**, click the drop-down list and select your office.

   d. For **Select Funds Type**, do not select any option.

   e. Click the **Finish** button.

4. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   **Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
• To wait and print directly from the onscreen display:
  a. From the Adobe toolbar that displays across the top of the report, click (Print).
  b. On the Print pop-up, to use the:
     o Default RTS Printer tray:
       Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
       1) From the Printer drop-down, select RTS-Tray-2.
       2) Click the Print button.
     o Manual feed tray of your RTS printer:
       1) Pull down Tray 1 and load paper into it.
       2) From the Printer drop-down, select RTS-Tray-1.
       3) Click the Print button.
  c. From the Cognos Viewer toolbar, click to return to the Finance reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click Select a delivery method.

b. From the options displayed, click Email Report.

c. On the Set the email options page, supply the necessary information.

d. Click the OK button to close this page and return to the Finance reports list.
Short Week Weekly Funds Remittance (Monday Reg)

If the last week of the month is a short week, the Weekly Funds Remittance report to get Registration information for that week must be run on the second business day after the month ends to get the correct data. If the last day of a month is on:

- Monday, run the report on the Wednesday two days later
- Tuesday, run the report on the Thursday two days later
- Wednesday, run the report on the Friday two days later
- Thursday, run the report on the following Monday

1. After logging into Cognos and displaying the Public Folders area on the Cognos Connection home page, click the Finance folder.

2. In the Finance reports list displayed, locate and click Funds Remittance Report.

**Note:** To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.
3. On the **Prompts** page:

   ![UI Image](image-url)

   a. For **Select Start Date**, click the calendar and select the date for the Monday of the previous week (for example, if you running this report on Tuesday, September 29, you would select Monday, September Monday 21).

   b. For **Select End Date**, click the calendar and select the date for this coming Sunday (or last Sunday if you are running this on the Monday for a short week that ended last Thursday).

   c. For **Select Office**, click the drop-down list and select your office.

   d. For **Select Funds Type**, do not click any option.

   e. Click the **Finish** button.

4. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.
**Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.

- To wait and print directly from the onscreen display:
  
  a. From the Adobe toolbar that displays across the top of the report, click (Print).
  
  b. On the **Print** pop-up, to use the:
     
     o **Default** RTS Printer tray:
       
       **Tip:** To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
       
       1) From the **Printer** drop-down, select **RTS-Tray-2**.
       2) Click the **Print** button.
     
     o **Manual feed** tray of your RTS printer:
       
       1) Pull down Tray 1 and load paper into it.
       2) From the **Printer** drop-down, select **RTS-Tray-1**.
       3) Click the **Print** button.
c. From the Cognos Viewer toolbar, click 🔄 to return to the Finance reports list.

• To email the report to yourself so you can send it to print later:
  a. On the pop-up, click Select a delivery method.
  
  ![Select a delivery method](image)

  b. From the options displayed, click Email Report.
  
  ![Email Report](image)

  c. On the Set the email options page, supply the necessary information.
  
  ![Set the email options](image)

  d. Click the OK button to close this page and return to the Finance reports list.
Sample Report

The Funds Remittance Report may span several pages to show all of the categories in which the funds were collected during the week specified and contains a summary of the CRBF owed on the last page.
The final page shows a summary of the CRBF.

<table>
<thead>
<tr>
<th>Funds Remittance Amounts</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Funds Report Date</td>
<td>Funds Category</td>
<td>Funds Remittance Amount ($)</td>
<td>County Amt ($)</td>
<td>Due Date: 09/05/2014</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------</td>
<td>-----------------------------</td>
<td>----------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>06/05/2014</td>
<td>SPL TxDot PRK</td>
<td>15.00</td>
<td>0.00</td>
<td>15.00</td>
</tr>
<tr>
<td></td>
<td>TRANS OF RBCS</td>
<td>45.00</td>
<td>22.50</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>VENDR ONLY CMN</td>
<td>2.00</td>
<td>2.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>VETERANS' FUND</td>
<td>2.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td><strong>Total ($) for 06/05/2014</strong></td>
<td><strong>26,355.96</strong></td>
<td><strong>3,598.70</strong></td>
<td><strong>137.00</strong></td>
</tr>
</tbody>
</table>

**CRBF Amounts**

<table>
<thead>
<tr>
<th>Year To Date</th>
<th>$293,332.23</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st Split</td>
<td>$176,930.23</td>
</tr>
<tr>
<td>2nd Split</td>
<td>$293,332.23</td>
</tr>
</tbody>
</table>

Signature:

Date: [Signature]

Note: Some Transactions will not display on the report for 48 hours.
Weekly Funds Transactions and Summary (Monday Reg/IRP) Information

The information gathered in the former 4602 Funds Transactions (Monday Registration / IRP) and 4603 Funds Summary (Monday Registration/IRP) reports is now available in the Fee Types Funds report in Cognos.

1. From the Finance reports list, locate and click Fee Type Funds Report.

Notes:
(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders area or click the Public Folder tab on the Cognos page currently displayed, and then click the Finance folder.
(2) To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.
2. On the **Prompts** page:

![Screen shot of Prompts page with input fields for Select Start Date, Select End Date, Select Office, and Select Fee Type]

- a. For **Select Start Date**, click the calendar and select the date for last Monday.

- b. For **Select End Date**, click the calendar and select the date for last Sunday.

- c. For **Select Office**, click the drop-down list and click your office.

- d. For **Select Fee Type**, click **Registration**.

- e. Click the **Finish** button.

3. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   **Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
• To wait and print directly from the onscreen display:
  a. From the Adobe toolbar that displays across the top of the report, click (Print).
  b. On the Print pop-up, to use the:
     o **Default** RTS Printer tray:
       **Tip:** To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
       1) From the Printer drop-down, select **RTS-Tray-2**.
       2) Click the Print button.
     o **Manual feed** tray of your RTS printer:
       1) Pull down Tray 1 and load paper into it.
       2) From the Printer drop-down, select **RTS-Tray-1**.
       3) Click the Print button.
  c. From the Cognos Viewer toolbar, click to return to the **Finance** reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click **Select a delivery method**.

b. From the options displayed, click **Email Report**.

c. On the **Set the email options** page, supply the necessary information.

d. Click the **OK** button to close this page and return to the **Finance** reports list.

4. Back on the **Finance** reports list page, click the **Fee Type Funds Report** again.

5. On the **Prompts** page:
   a. For **Select Start Date**, click the calendar and select the date for last Monday.
   
      b. For **Select End Date**, click the calendar and select the date for last Sunday.
c. For **Select Office**, click the drop-down list and select your office.

d. For **Select Fee Type**, click **IRP**.

e. Click the **Finish** button.

6. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   ![Image](https://via.placeholder.com/150)

   **Note**: If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.

   - To wait and print directly from the onscreen display:
      
      a. From the Adobe toolbar that displays across the top of the report, click **Print**.

      b. On the **Print** pop-up, to use the:

      o **Default** RTS Printer tray:

         **Tip**: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.

         1) From the **Printer** drop-down, select **RTS-Tray-2**.

         2) Click the **Print** button.

      o **Manual feed** tray of your RTS printer:

         1) Pull down Tray 1 and load paper into it.

         2) From the **Printer** drop-down, select **RTS-Tray-1**.

         3) Click the **Print** button.
c. From the Cognos Viewer toolbar, click to return to the Finance reports list.

- To email the report to yourself so you can send it to print later:
  a. On the pop-up, click Select a delivery method.
  
  ![Select a delivery method dialog box]

  b. From the options displayed, click Email Report.
  
  ![Email Report dialog box]

  c. On the Set the email options page, supply the necessary information.
d. Click the **OK** button to close this page and return to the **Finance** reports list.
Sample Report

The Fee Type Funds Reports typically span multiple pages to show a summary of all the fees associated with registration collected on each date in the week specified and then sections for each fee collected that show the specific transactions involved.

Page 1 shows the beginning of the Summary. It can be followed by multiple pages of the Summary.
After the Summary totals display, the individual details sections for each transaction display through the end of the report.

![Report Image]

<table>
<thead>
<tr>
<th>Date</th>
<th>Accounting Description</th>
<th>Amount ($)</th>
<th>Collected</th>
<th>Voided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total</td>
<td></td>
<td>24,355.95</td>
<td>1,531</td>
<td></td>
</tr>
</tbody>
</table>

- **30-DAY PERMIT**
  - Total Item Price: 150.00
  - Fees Collected: 6
  - Fees Voided: 0
  - **02/10/2014**
    - 00210041883135621 $25.00
    - 0221004188313559 $25.00
    - 02210041885162506 $25.00

- **72-HOUR PERMIT**
  - Total Item Price: 75.00
  - Fees Collected: 2
  - Fees Voided: 0
  - **02/10/2014**
    - 0021004188202342 $25.00
    - 02210041882140102 $25.00
    - 022100418804891322 $25.00

- **ADDL. WEIGHT**
  - Total Item Price: 55.00
  - Fees Collected: 1
  - Fees Voided: 0
  - **02/10/2014**
    - 002100418831301849 $55.00
Week-To-Date Cash Drawer and Week-To-Date Fees Information

The information gathered in the former 4552 Week to Date Cash Drawer and the 456B2, 456B3, and 456C4 Week to Date Fees reports is now available in sections of the Week/Month-To-Date Fees Report in Cognos.

1. In the Finance reports list displayed, locate and click the Week/Month-To-Date Fees Report.

Notes:
(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders area or click the Public Folder tab on the Cognos page currently displayed, and then click the Finance folder.
(2) To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.
2. On the Prompts page:

- a. For **Select Report Type**, be sure the **Weekly** option is selected.

- b. For **Select Week Date**, click the calendar and select last Sunday.

- c. For **Select Office**, click your office from the list displayed.
   
   **Note:** Do not select any option in the **Fee Type** area, which will provide the entire report.

- d. Click the **Finish** button.

3. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   **Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
• To wait and print directly from the onscreen display:
  a. From the Adobe toolbar that displays across the top of the report, click (Print).
  b. On the Print pop-up, to use the:
     o **Default** RTS Printer tray:
       Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
       1) From the Printer drop-down, select RTS-Tray-2.
       2) Click the Print button.
     o **Manual feed** tray of your RTS printer:
       1) Pull down Tray 1 and load paper into it.
       2) From the Printer drop-down, select RTS-Tray-1.
       3) Click the Print button.
  c. From the Cognos Viewer toolbar, click to return to the Finance reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click **Select a delivery method**.

![Select a delivery method](image)

b. From the options displayed, click **Email Report**.

![Email Report](image)

c. On the **Set the email options** page, supply the necessary information.

![Set the email options](image)

d. Click the **OK** button to close this page and return to the **Finance** reports list.
Sample Report

The Week/Month-To-Date Fees Report spans multiple pages with multiple sections in it (as shown in the sample report.)

Within the report, the:

- Total by Office section shows the fee source type and fees collected by day and ends with Grand Totals of this information.
- Total by Fee Source section shows the total amount of each type of fee collected by the office.
- Totals by Branch Office ($) section shows the amounts collected in each cash drawer.
- Funds Adjustments section shows the name of the fee adjusted, when it was made, and the amount of the adjustment as well as the grand total of adjustments.
Page 1 starts with the Total by Office section, which shows the fee source type and fees collected by day and may span multiple pages before it ends.
After the first section grand totals, other sections of information display, including the cash drawer information (in the Totals by Branch Office section) and the Adjustment section.
Weekly Inventory Transaction Information

The information gathered in the former 4702 Inventory Transaction report is now available in the Inventory Transaction Report in Cognos.

1. From the Finance reports list, click the Public Folders tab.
   
   **Notes:**
   (1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders area or click the Public Folder tab on the Cognos page currently displayed and then click the Finance folder.
   (2) To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report

2. Click the Inventory folder.

3. In the reports list displayed, locate and click Inventory Transactions Report.
   
   **Note:** To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.
4. On the **Prompts** page:

   ![Inventory Transactions Report](image)

   a. For **Select Start Date**, click the calendar and select the date for last Monday.

   b. For **Select End Date**, click the calendar and select the date for last Sunday.

   c. For **Select Office**, select your office from the list.

   d. Click the **Finish** button.

5. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   **Note**: If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
• To wait and print directly from the onscreen display:
  
a. From the Adobe toolbar that displays across the top of the report, click \(\text{Print}\) (Print).

b. On the Print pop-up, to use the:

   o **Default** RTS Printer tray:
     
     **Tip:** To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
     
     1) From the **Printer** drop-down, select **RTS-Tray-2**.
     2) Click the **Print** button.

   o **Manual feed** tray of your RTS printer:
     
     1) Pull down Tray 1 and load paper into it.
     2) From the **Printer** drop-down, select **RTS-Tray-1**.
     3) Click the **Print** button.

c. From the Cognos Viewer toolbar, click \(\text{to return to the Inventory reports list.}\)
• To email the report to yourself so you can send it to print later:
  
a. On the pop-up, click Select a delivery method.

b. From the options displayed, click Email Report.

c. On the Set the email options page, supply the necessary information.

d. Click the OK button to close this page and return to the Inventory reports list.
Sample Report

The Inventory Transactions report may span several pages to show all of the types of inventory selected for the report.

No sample is available at this time.
Weekly County IRP Transmittal Invoice Information

The information gathered in the former weekly 7472 County IRP Transmittal Invoice report is now available in Cognos as the Weekly County IRP Transmittal Invoice.

1. From the Finance reports list, locate and click Weekly County IRP Transmittal Invoice.

Notes:
(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders area or click the Public Folder tab on the Cognos page currently displayed, and then click the Finance folder.
(2) To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.

2. On the Prompts page:
a. For **Select Start Date**, click the and select the date for last Monday.

b. For **Select End Date**, click the and select the date for last Sunday.

c. For **Select Office**, select your office from the list.

d. Click the **Finish** button.

3. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

**Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.

- To wait and print directly from the onscreen display:
  a. From the Adobe toolbar that displays across the top of the report, click (Print).
  b. On the **Print** pop-up, to use the:
     - **Default** RTS Printer tray:
       Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
       1) From the **Printer** drop-down, select **RTS-Tray-2**.
       2) Click the **Print** button.
     - **Manual feed** tray of your RTS printer:
       1) Pull down Tray 1 and load paper into it.
       2) From the **Printer** drop-down, select **RTS-Tray-1**.
       3) Click the **Print** button.
c. From the Cognos Viewer toolbar, click to return to the Inventory reports list.

- To email the report to yourself so you can send it to print later:
  a. On the pop-up, click **Select a delivery method**.
  
  ![Select a delivery method](image)

  b. From the options displayed, click **Email Report**.
  
  ![Email Report](image)
c. On the **Set the email options** page, supply the necessary information.

![Set the email options page](image)

- Fill in the To, Cc, and Subject fields as needed.
- Adjust the content of the Body section as desired.
- Check or uncheck the Include a link to the report and Attach the report options.

![Set the email options - Fee Collection and Distribution Report](image)

- Click the **OK** button to close this page and return to the reports list.

   ![Click the OK button](image)
Sample Report

The Inventory Transactions report may span several pages to show all of the types of inventory selected for the report.

No sample is available at this time.
Running Monthly Reports

The monthly reports that you used to pull from your printer are now available to you to run manually as Cognos reports. The following sections include the steps for manually running the reports, including selecting the report and supplying values on the Prompts page that displays. Samples of the reports are provided at the end of each report section to help you work with the new reports.

Many of the names of the Cognos match up to the name of the former mainframe report (like the Funds Remittance Report and the Voided Transaction reports). However, some reports, like similarly named summary and detail reports, have been combined into one report that contains a summary section at the top and sets of details in their own tables.

The Cognos reports you can manually run for monthly information if you need this information include:

- **Monthly Funds Report** to gather the information in the former 4802 Monthly Funds report (such as the TERP, Registration Emission, Young Farmer, Texas Mobility Fund, and Sales Tax fees). You can run each type of fund individually, run them all, or select specific funds to run in one report.

- **Employee Transaction Report** to gather the information in the former 9482 Employee Production report.

- **Fee Collection and Distribution Report** to gather the information in the former 9353 Title and Registration Summary

- **Week/Month-To-Date Fees Report** to gather the information in the former 458B2 Month-to-Date Fees (Consolidated Collections) and 458B3 Month-to-Date Fees (Fee Source) reports.
Monthly Funds Information

The information gathered in the former 4802 Monthly Funds report (such as the TERP, Registration Emission, Young Farmer, Texas Mobility Fund, and Sales Tax fees) is now available in the **Monthly Funds Report** in Cognos.

1. From the Public Folders area, click the **Finance** folder.

   **Note:** If you are not on the Public Folders area, log in to Cognos to display the Public Folders area or click the Public Folder tab on the Cognos page currently displayed and then click the **Finance** folder.

2. In the **Finance** reports list displayed, locate and click the **Monthly Funds Report**.

   **Note:** To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click **Open in new tab**, and then click the tab open.
3. On the **Prompts** page:

   ![Texas Department of Motor Vehicles - Registration & Title System](image)

   - **Select Year**: Click the drop-down and select the year.
   - **Select Month**: Click the drop-down and select the previous month.
   - **Select County**: Click your county in the list displayed.
   - **Select Account Item Code**: Do not make a selection (which causes the report to run with all item codes displayed).
   - Click the **Finish** button.

4. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   **Note**: If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
To wait and print directly from the onscreen display:

a. From the Adobe toolbar that displays across the top of the report, click (Print).

b. On the Print pop-up, to use the:

   o **Default** RTS Printer tray:
     Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
     1) From the Printer drop-down, select RTS-Tray-2.
     2) Click the Print button.

   o **Manual feed** tray of your RTS printer:
     1) Pull down Tray 1 and load paper into it.
     2) From the Printer drop-down, select RTS-Tray-1.
     3) Click the Print button.

c. From the Cognos Viewer toolbar, click to return to the Finance reports list.
• To email the report to yourself so you can send it to print later:
  
a. On the pop-up, click **Select a delivery method**.

![Select a delivery method]

b. From the options displayed, click **Email Report**.

![Email Report]

c. On the **Set the email options** page, supply the necessary information.

![Set the email options]

d. Click the **OK** button to close this page and return to the **Finance** reports list.
Sample Report

The Monthly Funds report spans multiple pages. The Monthly Totals section shows the summary while the details for each category are contained in the remaining sections.
Monthly Title and Registration Summary Information

The information gathered in the former 9353 Title and Registration Summary is now available in the Fee Collection and Distribution Report in Cognos.

1. In the Finance reports list displayed, locate and click Fee Collection and Distribution Report.

   Notes:
   (1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders area or click the Public Folder tab on the Cognos page currently displayed and then click the Finance folder.
   (2) To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.
2. On the Prompts page:

   a. For **Select Start Year**, click the drop-down and select this year.
   
   b. For **Select End Year**, click the drop-down and select this year.
   
   c. For **Select Start Month**, click the drop-down list and click last month.
   
   d. For **Select Office Type**, click the **COUNTY** option.
   
   e. For **Select Office**, click your office.

   f. **For Funds Category**, click the appropriate option or do not select any option to report on all categories.

   g. Click the **Finish** button.

3. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   **Note**: If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
• To wait and print directly from the onscreen display:
  
a. From the Adobe toolbar that displays across the top of the report, click (Print).
  
b. On the Print pop-up, to use the:
  
  o **Default** RTS Printer tray:
    Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
    1) From the Printer drop-down, select RTS-Tray-2.
    2) Click the Print button.
  
  o **Manual feed** tray of your RTS printer:
    1) Pull down Tray 1 and load paper into it.
    2) From the Printer drop-down, select RTS-Tray-1.
    3) Click the Print button.
  
  c. From the Cognos Viewer toolbar, click to return to the Finance reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click Select a delivery method.

b. From the options displayed, click Email Report.

c. On the Set the email options page, supply the necessary information.

d. Click the OK button to close this page and return to the Finance reports list.
Sample Report

The Fee Collection and Distribution Report spans multiple pages with 3 sections:

- Inventory Item Counts section that runs down the left of the page
- Fees Collected section that starts on this page and continues until it is done
- Funds Distribution section that displays as the last section (refer to page 83)
The Funds Distribution section follows the end of the Fees Collected section and ends with an Overall Total on the last page of the report.
Month-To-Date Fees Information

The data contained in the former 458B2 Month-to-Date Fees (Consolidated Collections) and 458B3 Month-to-Date Fees (Fee Source) reports is now available in sections of the Week/Month-To-Date Fees Report in Cognos.

1. In the Finance reports list displayed, locate and click [Funds Remittance Report].

Notes:
(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders area or click the Public Folder tab on the Cognos page currently displayed, and then click the Finance folder.
(2) To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.
2. On the **Prompts** page:

   ![Image of the Prompts page]

   a. For **Select Report Type**, click the **Monthly** option.
   
b. For **Select Year**, click the drop-down list and click the year.
   
c. For **Select Month**, click the drop-down list and click last month.
   
d. For **Select Office**, click your office.
   
e. For **Select Total BreakDown Display**, leave **All** selected.
   
f. For **Select Fee Source**, do not make a selection (which causes the report to run with all fee sources displayed).
   
g. For **Select Account Item Code**, do not make a selection (which causes the report to run with all item codes displayed).
   
h. Click the **Finish** button.

3. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.
Note: If you are running each report in its own window, you can click the Public Folders tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.

- To wait and print directly from the onscreen display:
  a. From the Adobe toolbar that displays across the top of the report, click (Print).
  b. On the Print pop-up, to use the:
     o **Default** RTS Printer tray:
       Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
       1) From the Printer drop-down, select RTS-Tray-2.
       2) Click the Print button.
     o **Manual feed** tray of your RTS printer:
       1) Pull down Tray 1 and load paper into it.
       2) From the Printer drop-down, select RTS-Tray-1.
       3) Click the Print button.
  c. From the Cognos Viewer toolbar, click to return to the Finance reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click **Select a delivery method**.

b. From the options displayed, click **Email Report**.

c. On the **Set the email options** page, supply the necessary information.

d. Click the **OK** button to close this page and return to the **Finance** reports list.
Sample Report

Very similar to the weekly version of this report (on page 60), the Month-To-Date Fees Report spans multiple pages and includes several sections of information:

- Total by Office section shows the fee source type and fees collected by day and ends with Grand Totals of this information.
- Total by Fee Source section shows the total amount of each type of fee collected by the office.
- Totals by Branch Office ($) section shows the amount of money collected in each cash drawer.
- Funds Adjustments section shows the name of the fee adjusted, when the adjustment was made, and its amount as well as grand total of adjustments.
Page 1 starts with the Total by Office section, which shows the fee source type and fees collected by day and may span multiple pages before it ends.
After the first section grand totals, other sections of information display, including the cash drawer information (in the Totals by Branch Office section) and the Adjustment section.
Monthly Employee Production Information

The information gathered in the former 9482 Employee Production report is now available in the Employee Transaction Report in Cognos.

1. From the Finance reports list, click the Public Folders tab.  
   **Note:** If you are not on the Finance reports list, log in to Cognos to display the Public Folders area or click the Public Folder tab on the Cognos page currently displayed, and then click the Finance folder.

2. In the Public Folders area, click the Performance Support folder.

3. In the reports list displayed, locate and click Employee Transaction Report.  
   **Note:** To open this report and run it in its own tab (so you can run multiple reports at one time), right-click the report, click Open in new tab, and then click the tab open.
4. On the **Prompts** page:

   ![Prompts Page Image]

   a. For **Select Start Date**, click the calendar and select the first business day of last month.

   b. For **Select End Date**, click the calendar and select the last business day of last month.

   c. For **Select Office Type**, click **COUNTY** and then click the **Refresh** button.

   d. For **Select Transaction Type**, do not make a selection (which causes the report to run with all transaction types displayed).

   e. For **Select Office**, click the office where the employees work and click the **Refresh** button below the list.

   f. For **Select Employee Name**, do not select anything (which selects all of the employees shown in the list).

   g. Click the **Finish** button.

5. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background.
and have the system email it to you when the report finishes running.

**Note:** If you are running each report in its own window, you can click the Public Folders tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.

- To wait and print directly from the onscreen display:
  
  a. From the Adobe toolbar that displays across the top of the report, click (Print).
  
  b. On the Print pop-up, to use the:
     
     o **Default** RTS Printer tray:
       
       **Tip:** To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
       
       1) From the Printer drop-down, select RTS-Tray-2.
       2) Click the Print button.
     
     o **Manual feed** tray of your RTS printer:
       
       1) Pull down Tray 1 and load paper into it.
       2) From the Printer drop-down, select RTS-Tray-1.
       3) Click the Print button.
  
  c. From the Cognos Viewer toolbar, click to return to the Performance Support reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click **Select a delivery method**.

b. From the options displayed, click **Email Report**.

c. On the **Set the email options** page, supply the necessary information.

d. Click the **OK** button to close this page and return to the **Performance Support** reports list.
Sample Report

This Employee Transaction Report can span multiple pages depending on the number of employees and the transaction types selected. Each employee is listed within a section and the sections may break over several pages. The total number of transactions and the total number of days worked are available at the end of each employee section.
Other Report Information

The following sections explain how to locate the legacy report information in Cognos reports that you can run on demand when you need them:

- Apprehension information on page 97
- County road and bridge fund (CRBF) information on page 101
- $5 buyer tag fee information on page 106
Apprehension Information

Apprehension information (formerly run as 4672 Apprehension Report) is now gathered in the daily and weekly Funds Remittance report described in previous sections of this guide and displays as a section of information if any apprehensions occurred within the timeframe when the report is run.

You can also run the Week/Month-To-Date Fees and select APPREHENSIONS as a Fee Source if you are looking for that information.

To run the Week/Month to Date report:

1. From the Public Folders area on the Cognos Connection home page, click the Finance folder.

   **Note:** If you are not on the Public Folders area, log in to Cognos to display this tab area or click the Public Folders tab on the Cognos page currently displayed.

2. In the Finance reports list displayed, locate and click the Week/Month-To-Date Fees Report.
3. On the **Prompts** page:

   a. For **Select Report Type**, click the appropriate option.

   b. For **Select Date**, click the **Date** and select the appropriate dates.

   c. For **Select Office**, click your office from the list displayed.

   d. For **Select Fee Type**, click **APPREHENSIONS**.

   e. Click the **Finish** button.

4. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   **Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
To wait and print directly from the onscreen display:

a. From the Adobe toolbar that displays across the top of the report, click (Print).

b. On the Print pop-up, to use the:

   o **Default** RTS Printer tray:
     Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
     1) From the Printer drop-down, select RTS-Tray-2.
     2) Click the Print button.

   o **Manual feed** tray of your RTS printer:
     1) Pull down Tray 1 and load paper into it.
     2) From the Printer drop-down, select RTS-Tray-1.
     3) Click the Print button.

c. From the Cognos Viewer toolbar, click to return to the Finance reports list.
To email the report to yourself so you can send it to print later:

a. On the pop-up, click **Select a delivery method**.

b. From the options displayed, click **Email Report**.

c. On the **Set the email options** page, supply the necessary information.

d. Click the **OK** button to close this page and return to the **Finance** reports list.
CRBF Information

The County Road and Bridge Fee (CRBF) information is gathered in the CRBF Report in Cognos in the Finance Folder.

1. On the Public Folders area, click the Finance folder.

   **Note:** If you are not on the Public Folders area, log in to Cognos to display this tab area or click the Public Folders tab on the Cognos page currently displayed.

2. In the reports list displayed, locate and click the CRBF Report.
3. On the **Prompts** page:

![Image of the Texas Department of Motor Vehicles Registration & Title System CRBF Report page]

   a. For **Select Start Date**, click the **[ ]** and select the appropriate date.

   b. For **Select End Date**, click the **[ ]** and select the appropriate date.

   c. For **Select County**, click your office from the list displayed.

   d. Click the **Finish** button.

4. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

   **Note**: If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
• To wait and print directly from the onscreen display:
  a. From the Adobe toolbar that displays across the top of the report, click (Print).
  b. On the Print pop-up, to use the:
     o **Default** RTS Printer tray:
       Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
       1) From the **Printer** drop-down, select **RTS-Tray-2**.
       2) Click the **Print** button.
     o **Manual feed** tray of your RTS printer:
       1) Pull down Tray 1 and load paper into it.
       2) From the **Printer** drop-down, select **RTS-Tray-1**.
       3) Click the **Print** button.
  c. From the Cognos Viewer toolbar, click to return to the **Finance** reports list.
• To email the report to yourself so you can send it to print later:
  a. On the pop-up, click **Select a delivery method**.

  ![Select a delivery method](image)

  b. From the options displayed, click **Email Report**.

  ![Email Report](image)

  c. On the **Set the email options** page, supply the necessary information.

  ![Set the email options](image)

  d. Click the **OK** button to close this page and return to the **Finance** reports list.
# Sample Report

## Texas Department of Motor Vehicles

### Registration & Title System

**CRBF REPORT**
For 08/31/2014 - 09/05/2014

<table>
<thead>
<tr>
<th>County</th>
<th>Date</th>
<th>CRBF First Level Split Amount ($)</th>
<th>CRBF Second Level Split Amount ($)</th>
<th>CRBF Amount ($)</th>
<th>CRBF YTD Amount ($)</th>
<th>CRBF County Amount ($)</th>
<th>CRBF State Amount ($)</th>
<th>CRBF State Amount YTD ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>002 - ANDREWS</td>
<td>Aug 2014</td>
<td>175,939.00</td>
<td>301,939.00</td>
<td>117.00</td>
<td>1,324,185.00</td>
<td>0.00</td>
<td>301,939.00</td>
<td>117.00</td>
</tr>
</tbody>
</table>

## CRBF Year-to-Date Amount by County Detail Report

<table>
<thead>
<tr>
<th>County</th>
<th>Date</th>
<th>CRBF First Level Split Amount ($)</th>
<th>CRBF Second Level Split Amount ($)</th>
<th>CRBF Amount ($)</th>
<th>CRBF YTD Amount ($)</th>
<th>CRBF County Amount ($)</th>
<th>CRBF State Amount ($)</th>
<th>CRBF State Amount YTD ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>002 - ANDREWS</td>
<td>31 - Aug</td>
<td>175,939.00</td>
<td>301,939.00</td>
<td>117.00</td>
<td>1,324,185.00</td>
<td>0.00</td>
<td>301,939.00</td>
<td>117.00</td>
</tr>
</tbody>
</table>
$5 Buyer Tag Fee Information

The $5 Buyer Tag Fee information is gathered in the $5 Buyer Tag Fees Report in Cognos in the Finance Folder. You can report on information for a month. You can also select a specific dealer to report on.

1. In the Public Folders area, click the Finance folder.

   **Note:** If you are not on the Public Folders area, log in to Cognos to display this tab area or click the Public Folders tab on the Cognos page currently displayed.

2. In the Finance reports list displayed, locate and click the $5 Buyer Tag Fees Report.
3. On the **Prompts** page:

![Prompts page image](image)

a. For **Select Start Date**, click the drop-down list and select the appropriate date.

b. For **Select End Date**, click the drop-down list and select the appropriate date.

c. For **Select County**, click your office from the list displayed.

d. Click the **Finish** button.

4. When the **Your report is running** pop-up displays, you can wait for the report to finish running and print it from the onscreen display or run the report in the background and have the system email it to you when the report finishes running.

**Note:** If you are running each report in its own window, you can click the **Public Folders** tab to return to the reports list and run the next report. And then, follow the instructions in Appendix E on page 120.
To wait and print directly from the onscreen display:

a. From the Adobe toolbar that displays across the top of the report, click (Print).

b. On the Print pop-up, to use the:

   o **Default** RTS Printer tray:
     Tip: To avoid using up the “500” paper inventory, you can load some plain paper in this tray.
     1) From the Printer drop-down, select **RTS-Tray-2**.
     2) Click the Print button.

   o **Manual feed** tray of your RTS printer:
     1) Pull down Tray 1 and load paper into it.
     2) From the Printer drop-down, select **RTS-Tray-1**.
     3) Click the Print button.

c. From the Cognos Viewer toolbar, click to return to the Finance reports list.
• To email the report to yourself so you can send it to print later:
  a. On the pop-up, click **Select a delivery method**.

  ![Select a delivery method](image)

  b. From the options displayed, click **Email Report**.

  ![Email Report](image)

  c. On the **Set the email options** page, supply the necessary information.

  ![Set the email options](image)

  d. Click the **OK** button to close this page and return to the **Finance** reports list.
# Sample Report

## Texas Department of Motor Vehicles

### Registration & Title System

**$5 Buyer Tag Fees**

For: September 2014

<table>
<thead>
<tr>
<th>Trans Code</th>
<th>Trans Count w/ Dealer Number</th>
<th>w/ Buyertag</th>
<th>Tax Date prior to Sept. 1, 2008</th>
</tr>
</thead>
<tbody>
<tr>
<td>NONTTL</td>
<td>7</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>TITLE</td>
<td>155</td>
<td>79</td>
<td>72</td>
</tr>
<tr>
<td><strong>Totals</strong></td>
<td><strong>162</strong></td>
<td><strong>85</strong></td>
<td><strong>76</strong></td>
</tr>
</tbody>
</table>

### $5 Dealer Tag Fees Not NGC

<table>
<thead>
<tr>
<th>County</th>
<th>Trans ID</th>
<th>Trans Code</th>
<th>GDN</th>
<th>Exempt Code</th>
<th>Class Code</th>
<th>Doc Type</th>
<th>Evidence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z - ANDREWS</td>
<td>00201041888342800</td>
<td>2941</td>
<td>0</td>
<td>35</td>
<td>1</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Z - ANDREWS</td>
<td>00201041888342800</td>
<td>2941</td>
<td>0</td>
<td>35</td>
<td>1</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Z - ANDREWS</td>
<td>00201041888342800</td>
<td>2941</td>
<td>0</td>
<td>35</td>
<td>1</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Z - ANDREWS</td>
<td>00201041888342800</td>
<td>2941</td>
<td>0</td>
<td>35</td>
<td>1</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Z - ANDREWS</td>
<td>000809</td>
<td>000809</td>
<td>0</td>
<td>35</td>
<td>1</td>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>

- **Dealer Transactions not collecting $5 for Z - ANDREWS:** 7
- **Exempt Dealer Transactions not collecting $5 for Z - ANDREWS:** 0
- **TOTAL Dealer Transactions not collecting $5:** 7
- **TOTAL Exempt Dealer Transactions not collecting $5:** 9
Appendix A. Daily Reports Quick Path

Running the Daily Cognos Reports

1. Click (Cognos Reports) and log in.
2. Click Finance.
3. Click Funds Remittance Report.
4. For Prompts:
   - Select Start Date = Business day before yesterday
   - Select End Date = Same as above
   - Select Office = Your office
   - Select Funds Type = TITLE
5. Click Finish.
6. Click.
7. Click RTS Tray 2 (or Tray 1 if you have loaded paper).
8. Click Print.
9. Click (to return to the last reports list)
10. Click Fee Type Funds Report.
11. For Prompts:
    - Select Start Date = Yesterday
    - Select End Date = Yesterday again
    - Select Office = Your office
    - Select Fee Type = Title
12. Click Finish.
13. Click.
14. Click RTS Tray 2 (or Tray 1 if you have loaded paper).
15. Click **Print**.

16. Click 📞.

17. Click 📚 **Registration**.

18. Click 📚 **Special Plates Registration**.

19. Click 📚 ► **County Special Plates Invoice Report**.

20. For **Prompts**:
   - **Transaction Start Date** = *Yesterday*
   - **Transaction End Date** = *Yesterday*
   - **Office** = *Your office*

21. Click **Finish**.

22. Click 📞.

23. Click **RTS Tray 2** (or Tray 1 if you have loaded paper).

24. Click **Print**.

25. Click 📞.

26. Click 📚 **Administrative**.

27. Click 📚 ► **Voided Transactions Report**.

28. For **Prompts**:
   - **Transaction Start Date** = *Yesterday*
   - **Transaction End Date** = *Yesterday*
   - **Office Type** = COUNTY (Refresh **Office** button).
   - **Office** = *Your office*

29. Click **Finish**.

30. Click 📞.

31. Click **RTS Tray 2** (or Tray 1 if you have loaded paper).

32. Click **Print**.
33. Click 📊.

34. Click 📜 Title.

35. Click 📌 NMVITIS Inquiry Report.

36. For Prompts:
   - Select Start Date = Yesterday
   - Select End Date = Yesterday
   - Select Type = Error
   - Select Salvage Indicator = Non-Salvage
   - Select Office = Your office

37. Click Finish.

38. Click 📍.

39. Click RTS Tray 2 (or Tray 1 and load paper).

40. Click Print.

Running the Daily RTS POS Reports (Main Office)

1. Click 📦 and log in.

2. Click Reports > Reprint Reports.

3. On Reprint Reports RPR002, click Shift +:
   - Batch Inventory
   - Completed Set Aside Transactions
   - Countywide Batch
   - Title Package

4. Click Enter.

5. Click Funds.

6. Click Substation Batch Summary.

7. Click Enter.

Print Note:
To fit the NMVITIS report on a page so it is readable, change Print settings:
- Portrait Orientation > Landscape Orientation
- No scaling > Fit all columns on One Page
Appendix B. Weekly Reports Quick Path

1. Click and log in.

2. Click Finance.

3. Click Funds Remittance Report.

4. For Prompts:
   - Select Start Date = Monday (of prev week)
   - Select End Date = Last Sunday
   - Select Office = Your office
   - Select Funds Type = no selection

5. Click Finish.

6. Click .

7. Click RTS Tray 2 (or Tray 1 if you have loaded paper).

8. Click Print.

9. Click .

10. Click Fee Type Funds Report.

11. For Prompts:
    - Select Start Date = Monday (of previous week)
    - Select End Date = Last Sunday
    - Select Office = Your office
    - Select Fee Type = Registration

12. Click Finish.

13. Click .

14. Click RTS Tray 2 (or Tray 1 if you have loaded paper).

15. Click Print.

16. Click .

For a short week, you must run this report on the 2nd business day after the month ends using the following prompts:

- Select Start Date = Previous Monday
- Select End Date = Upcoming Sunday (or Last Sunday if running this on the Monday for a short week that ended last Thursday)
- Select Office = Your office
- Select Funds Type = no selection
17. Click Fee Type Funds Report.

18. For Prompts:
   - Select Start Date = Last Monday
   - Select End Date = Last Sunday
   - Select Office = Your office
   - Select Fee Type = IRP

19. Click Finish.

20. Click .

21. Click RTS Tray 2 (or Tray 1 if you have loaded paper).

22. Click Print.

23. Click .

24. Click Week/Month-To-Date Fees Report.

25. For Prompts:
   - Select Report Type = Weekly
   - Select Week Date = Last Monday
   - Select Office = Your office
   **Note:** Do not make any selection for Fee Type to print entire report.

26. Click Finish.

27. Click .

28. Click RTS Tray 2 (or Tray 1 if you have loaded paper).

29. Click Print.

30. Click .

31. Click Inventory.

32. Click Inventory Transactions Report.
33. For Prompts:
   - **Select Start Date** = *Last Monday*
   - **Select End Date** = *Last Sunday*
   - **Select Office** = *Your office*

34. Click **Finish**.

35. Click 🗂.

36. Click **RTS Tray 2** (or Tray 1 if you have loaded paper).

37. Click **Print**.

38. In the **Task** bar at the bottom left of your computer screen, click the **File Explorer** icon.

39. In the address bar at the top of the **File Explorer** page:
   a. Click in the open space to the right of the word **Libraries**.
   b. On your keyboard, press the letter **D** and then the : (colon) key.
   c. Press the **Enter** key.

40. In the list of folders displayed, locate and double-click the **RTS** folder.

41. In the list of folders displayed, locate and double-click the **DL** folder.

42. In the list of report files displayed, locate and double-click the appropriate **IRP** report.

43. On the **Full Screen** prompt, click the:
   - **Yes** button to use your entire screen to display the report
   - **No** button to display the report in a smaller window on your screen.

44. At the top of the Adobe report page, click the **File** menu and click **Print** (or click the 🖨 icon).
Appendix C. Monthly Reports Quick Path

1. Click and log in.

2. Click Finance.

3. Click Monthly Funds Report.

4. For Prompts:
   - Select Year = This year
   - Select Month = Last month
   - Select County = Your county

5. Click Finish.

6. Click .

7. Click RTS Tray 2 (or Tray 1 if you have loaded paper).

8. Click Print.

9. Click .


11. For Prompts:
    - Select Start Year = This year
    - Select End Year = This year
    - Select Start Month = Last month
    - Select Office Type = COUNTY
    - Select Office = Your office
    - Select Funds Category = Appropriate options

12. Click Finish.

13. Click .

14. Click RTS Tray 2 (or Tray 1 if you have loaded paper).

15. Click Print.
16. Click 

17. Click ➤ Funds Remittance Report.

18. For Prompts:
   - Select Report Type = Monthly
   - Select Year = This year
   - Select Month = Last month
   - Select Office = Your office
   - Select Total BreakDown Display = All

19. Click Finish.

20. Click 

21. Click RTS Tray 2 (or Tray 1 if you have loaded paper).

22. Click Print.

23. Click 

24. Click Performance Support.

25. Click ➤ Employee Transaction Report.

26. For Prompts:
   - Select Start Date = First business day of last month
   - Select End Date = Last business day of last month
   - Select Office Type = COUNTY
   - Select Office = Your office

27. Click Finish.

28. Click 

29. Click RTS Tray 2 (or Tray 1 if you have loaded paper).

30. Click Print.
Appendix D. Daily Substation RTS POS Reports Quick Path

1. Click and log in.
2. Click **Reports > Reprint Reports**.
3. Click **Funds**.
4. Click **Ctrl +**:
   - Batch Inventory
   - Title Package
5. Click **Enter**.
6. Click **Funds**.
7. Click **Substation Summary Online**.
8. Click **Enter**.
Appendix E. Printing Cognos Reports

By default, most Cognos reports described in this guide are generated as PDFs for easy online reading and the preferred method for printing these reports is from the PDF while viewing online as described in the appropriate sections in this manual. (The generic steps are repeated below.)

However, there may be times when you need to reduce the page count of a large report to save paper. To do this, you can export the processed PDF report into Excel and work with page and print options in Excel (such as the Page Layout or Scaling) that may help reduce the number of pages to print. These instructions describing how to export the PDF report into Excel and print the Excel file are on page 121.

Printing a Cognos Report PDF from the Cognos Viewer

1. From the Adobe toolbar that displays across the top of the report, click (Print).

2. On the Print pop-up, to use the:
   - **Default** RTS Printer tray:
     Tip: To avoid using up the “500” paper inventory, load plain paper in this tray.
     a. From the Printer drop-down list, select RTS-Tray-2.
     b. Click the Print button.
   - **Manual feed** tray of your RTS printer:
     a. Pull down Tray 1 and load paper into it.
     b. From the Printer drop-down list, select RTS-Tray-1.
     c. Click the Print button.
     d. From the Cognos Viewer toolbar, click to return to the previous reports list.
Exporting a Cognos Report PDF into Excel and Printing It


2. On the prompt displayed at the bottom of the page, click the Open button.

3. If the Enable Editing button displays along the top of the Excel spreadsheet, click it to grant access to the file.

4. On the toolbar at the top of the Excel spreadsheet, click File > Print.
5. On the Print page:

a. Make sure the appropriate Printer is set.

   **Tip:** To avoid printing on the “500” paper inventory, add plain paper to **Tray 2** of the RTS printer or pull down **Tray 1** (the manual feed tray) and load it.

b. Use the **Settings** and **Custom Scaling Options** to help shrink the information onto normal-sized print pages.

   For example, in the **Settings** area:
   - Click **Portrait Orientation** drop-down and select **Landscape**.
   - Click the **Normal Margins** drop-down and reset the margins.
   - Click **Fit All Columns on One** page (as shown).

6. Click the Print button.
# Appendix F. Locating the Mainframe Reports Formerly Downloaded and Printed Automatically

**To locate information from the former:**

<table>
<thead>
<tr>
<th>Category</th>
<th>In Cognos, go to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apprehension Report (4672)</td>
<td><img src="image" alt="Finance &gt; Funds Remittance Report" /></td>
</tr>
<tr>
<td>Funds Remittance Report (4604, 4605)</td>
<td><img src="image" alt="Finance &gt; Funds Remittance Report" /></td>
</tr>
<tr>
<td>Funds Summary² (4603)</td>
<td><img src="image" alt="Finance &gt; Fee Type Funds Report" /></td>
</tr>
<tr>
<td>Funds Transactions² (4602)</td>
<td><img src="image" alt="Inventory &gt; Inventory Transactions Report" /></td>
</tr>
<tr>
<td>Inventory Transactions (4702)</td>
<td><img src="image" alt="Finance &gt; Monthly Funds Report" /></td>
</tr>
<tr>
<td>Monthly Funds Report</td>
<td><img src="image" alt="Finance &gt; Monthly Funds Report" /></td>
</tr>
<tr>
<td>Sales Tax Penalty (4802)</td>
<td><img src="image" alt="Finance &gt; Monthly Funds Report" /></td>
</tr>
<tr>
<td>Young Farmer (4802)</td>
<td><img src="image" alt="Finance &gt; Monthly Funds Report" /></td>
</tr>
<tr>
<td>Registration Emissions Fee (4802)</td>
<td><img src="image" alt="Finance &gt; Monthly Funds Report" /></td>
</tr>
<tr>
<td>Month-To-Date Fees Report (458b2/458b3)</td>
<td><img src="image" alt="Finance &gt; Week/Month-to-Date Fees Report" /></td>
</tr>
<tr>
<td>NMVTIS Inquiry Report (366a4)</td>
<td><img src="image" alt="Title &gt; NMVTIS Inquiry Error Report" /></td>
</tr>
<tr>
<td>Production Report (9482)</td>
<td><img src="image" alt="Performance Support &gt; Employee Transaction" /></td>
</tr>
<tr>
<td>Sales Tax Emission Fee 1% (4802)</td>
<td><img src="image" alt="Finance &gt; Monthly Funds Report" /></td>
</tr>
<tr>
<td>Sales Tax Report (4802)</td>
<td><img src="image" alt="Finance &gt; Monthly Funds Report" /></td>
</tr>
<tr>
<td>Special Plates County Invoice (3564)</td>
<td><img src="image" alt="Registration &gt; Special Plates Registration &gt; County Special Plates Invoice Report" /></td>
</tr>
<tr>
<td>TERP Fee (4802)</td>
<td><img src="image" alt="Finance &gt; Monthly Funds Report" /></td>
</tr>
<tr>
<td>Texas Mobility Fund Fee (4802)</td>
<td><img src="image" alt="Finance &gt; Monthly Funds Report" /></td>
</tr>
<tr>
<td>Voided Transaction Report (5152)</td>
<td><img src="image" alt="Administrative &gt; Voided Transactions Report" /></td>
</tr>
<tr>
<td>Week-To-Date Cash Drawer (4552)</td>
<td><img src="image" alt="Finance &gt; Week/Month-to-Date Fees Report" /></td>
</tr>
<tr>
<td>Week-To-Date Fees Report (456b2/B3/C4)</td>
<td><img src="image" alt="Finance &gt; Week/Month-to-Date Fees Report" /></td>
</tr>
<tr>
<td>Weekly County IRP Transmittal invoice (7472)</td>
<td><img src="image" alt="Finance &gt; Weekly County IRP Transmittal invoice" /></td>
</tr>
<tr>
<td>Year-To-Date Reg &amp; Title Summary (9352)</td>
<td><img src="image" alt="Finance &gt; Fee Collection and Distribution Report" /></td>
</tr>
</tbody>
</table>

**To print the:**

<table>
<thead>
<tr>
<th>Category</th>
<th>In the POS, go to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Inventory Action – BIAR (9901)</td>
<td>Reports &gt; Reprint Reports</td>
</tr>
<tr>
<td>Completed Set Aside Transactions (9021)</td>
<td>Reports &gt; Reprint Reports</td>
</tr>
<tr>
<td>County Wide Payment, Fees, Inventory, Exception (5902/5903/5904)</td>
<td>Reports &gt; Reprint Reports</td>
</tr>
<tr>
<td>Substation Summary Payment, Fees, Inventory (5921/5922/5923)</td>
<td>Reports &gt; Reprint Reports</td>
</tr>
<tr>
<td>Title Package Report (5911)</td>
<td>Reports &gt; Reprint Reports</td>
</tr>
</tbody>
</table>

1. Prints as a column in the report when apprehension data is available

2. Now runs as one report; the Summary displays at the top while the transactions display in the sections that follow the Summary.